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Copyright statement  
 

Copyright MacVector, Inc, 2020. All rights reserved.  

This document contains proprietary information of MacVector, Inc and 

its licensors.  It is their exclusive property.  It may not be reproduced or 

transmitted, in whole or in part, without written agreement from 

MacVector, Inc.  

The software described in this document is furnished under a license 

agreement, a copy of which is packaged with the software.  The software 

may not be used or copied except as provided in the license agreement.  

MacVector, Inc reserves the right to make changes, without notice, both 

to this publication and to the product it describes.  Information concerning 

products not manufactured or distributed by MacVector, Inc is provided 

without warranty or representation of any kind, and MacVector, Inc will 

not be liable for any damages.   

This version of the clone construction tutorial was published in January 

2020. 
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Overview 

The tutorial will show you how to use MacVector to create new plasmids 

by replicating cloning experiments that you might perform in a practical 

laboratory. This tutorial focuses on the common restriction enzyme based 

approach, but there are sections discussing Gateway and Gibson cloning 

techniques too. There are two main approaches that you can use in 

MacVector to create constructs based on restriction enzyme cut sites; 

(a) Copy and Paste – this is directly analogous to copying and pasting 

sentences or paragraphs between Microsoft Word documents. You 

simply select the source fragment, copy, select an insertion point or 

section to replace, then choose paste. As MacVector is sticky-end 

aware, it will never let you create biologically invalid constructs. 

(b) Cloning Clipboard – the second approach is that you use the “Digest” 

function to place selected fragments on the Cloning Clipboard. Once 

on the clipboard, you can join fragments together by dragging ends 

onto each other. 

Configuring “Auto” Restriction Enzymes 

Whenever you open a DNA sequence, MacVector automatically runs a 

restriction enzyme search on the sequence and displays the results 

graphically in the Map tab. This dynamic or “auto” restriction enzyme 

search is primarily designed to show you the locations of common 

enzymes that cut your DNA. There is a more comprehensive restriction 

enzyme searching function available in the Analyze menu that can be used 

for in-depth analysis of the restriction enzyme sites in DNA. However, the 

“Auto” restriction enzyme analysis is often more than adequate for most 

basic clone construction DNA manipulations.  

 

 

 

While the default settings are usually sufficient for this tutorial, to ensure 

the automatic restriction enzyme searching parameters are set correctly, 

let’s make sure our preferences are set appropriately. 

 

 

 

Open the files Gal cosmid and pBR322. You will find these in the 

/MacVector/Sample Files/ folder. Make sure you have the Gal 

Cosmid window front-most, and then click on the Map tab if it is not 

already active. 
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The Common Enzymes file opens in a Restriction Enzyme Editor window.  

In this window, you can click on any enzyme name and a check mark 

appears next to the enzyme indicating it is selected. For example, if you 

click on the BamHI entry, you will see the checkmark toggle on and off. 

At the same time, if you look at the pUC19 Map view, you will see the 

BamHI site turning on and off as you select/deselect the enzyme. 

 

 

 

 

Using the Restriction Enzyme Picker 

A new feature added in MacVector 17 is a floating Restriction Enzyme 

Picker. When a sequence is opened, this is populated with the restriction 

enzymes as defined by the default Scan DNA settings.  

Make sure the enzymes BamHI, EcoRI, NotI, SmaI and SalI are selected 

(you can leave others selected as well). You can permanently save your 

favorite selections in the file by selecting Save in the File menu. 



 

Click Cloning Tutorial   27 January 2020 

 

Click Cloning Tutorial    6 

 

The interface is dynamic, so if you click on the highlighted EcoRI site 

above, the checkbox will deselect and any EcoRI sites in the currently 

active sequence document will become hidden. 

One of the key concepts of the RE Picker is that when a sequence is initially 

opened, ALL of the enzymes in the default file are scanned against the 

target sequence, not just those that were selected in the original .renz file. 

So, you can drag the sliders in the Filter area and all of the restriction 

enzymes that are displayed in the RE Picker are those that have the selected 

cuts/size/end structure in the molecule. However, only those that have a 

checkbox next to them are displayed in the Map view.  

You can continue to play with the filter controls and selecting/deselecting 

enzymes to suit your needs. However, there are often times when you just 

want to get back to the original default set of enzymes. 

This reverts everything back to the initial state, the same as it would be if 

you closed the document window and re-opened it. 

It should be noted that at any time you can click on the Save current set of 

Enzymes button in the REPicker and the currently displayed enzymes are 

saved to a new file, complete with their selection status. 

Clone Construction Using Copy/Paste 

This section will show you how to create constructs using a simple 

“Select, Copy, Paste” approach. The basic concept is similar to how you 

might approach moving sentences between Microsoft Word documents: 

First select the source sentence, choose Copy, then move to the target 

document, select the insertion position, or sentence to be replaced, then 

Click on the Defaults button in the RE Picker window. 
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choose Paste. MacVector is “sticky-end” aware and will never allow you 

to create invalid constructs. If you try to paste a fragment into an 

incompatible site, a dialog will be presented warning about the 

incompatibility, but also allowing you to modify the ends if appropriate. 

A Simple Single Enzyme Cloning 

Lets copy an EcoRI fragment from Gal Cosmid and insert it into the 

EcoRI site of pBR322. 

 

You will see a graphical map of the cosmid with the locations of the cut 

sites displayed. There should also be a floating palette window with the 

title Gal cosmid available. If you don’t see this, look in the Windows menu 

and select Show Graphics Palette or click on the Graphics toolbar button.  

 

 

 

The display should resize so that you can see the entire cosmid on a single 

line. If you look closely, you will see that there is a red colored galK gene 

in the middle of the sequence. In addition, there are two EcoRI sites in the 

cosmid and they conveniently lie on either side of the galK gene. 

Make sure the Gal Cosmid window is frontmost and the Map tab is 

active. 

Click on the Fit to Window button in the floating palette window. 
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The two sites highlight, along with the section of sequence between them. 

 

This copies the selected sequence to the clipboard. It’s important to note 

that the features on that fragment, and information about the structure of 

the ends of the fragment, are also copied. This is the actual sequence of 

any overhanging ends, not just the name of the enzyme or the consensus 

sequence of its recognition site. 

 

 

You should be prompted to unlock the pBR322 sequence. This is to 

prevent you from accidentally modifying an important sequence file.  

The display updates to show a new molecule with the EcoRI fragment 

from Gal Cosmid inserted into the EcoRI site of pBR322. If you look 

carefully, you can see the two EcoRI sites flanking the inserted fragment. 

Note how all of the features have been included on the copied fragment. 

Click on the first EcoRI site at 13,316. Hold down the <shift> key and 

click on the second EcoRI site at 16,089. 

Choose Edit | Copy 

Switch to the pBR322 window. Click on the EcoRI site at 12 o’clock to 

select it, then choose Edit | Paste. 
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Lets see what happens if we try to insert the copied fragment into an 

incompatible site. 

 

 

 

A ligation dialog will appear warning you that the fragment cannot be 

inserted because the sequence ends are not compatible. 

 

The dialog lets you fill or cut back the ends if you wish so that you can 

force a blunt-ended cloning. But you can be confident that MacVector will 

never let you accidentally create an invalid construct using this Copy-

Paste approach. 

Choose Edit | Undo. MacVector has essentially unlimited levels of undo, 

so you can undo almost any action you make. Now select the BamHI site 

at 375 and choose Edit | Paste. 
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Flipping The Inserted Fragment 

Of course, there may be times when you want the fragment inserted in the 

opposite orientation. MacVector has a simple trick for this; 

Note how that while you hold down the <option> key, the Paste menu 

item changes to Paste Flipped. If you release the <option> key the menu 

title reverts to Paste. 

 

The display updates to show the fragment inserted in the opposite 

orientation. Compare the image below with the equivalent image above. 

 

Click on the Cancel button to dismiss the ligation dialog. Click back on 

the EcoRI site, hold down the <option> key and click on the Edit menu. 

While holding down the <option> key, choose the Edit | Paste Flipped 

menu item 
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Two Enzyme Directed Cloning 

Quite often, you will find it convenient to perform cloning experiments 

using two different enzymes. In these cases, the fragment can typically 

only be inserted in one orientation, but MacVector understands this and 

will automatically “flip” the fragment if required to maintain compatibility 

between ends. 

 

 

 

 

 

There are a couple of things to note here; 

(i) The sticky end produced by BamHI cleavage (5’ GATC – 3’) is 

identical to that generated by BglII cleavage. Because MacVector 

looks at the actual structure of the overhang, not the enzymes that 

created the overhang, it will recognize that the two ends are 

compatible. Similarly, the ends produced by SalI and XhoI are 

compatible. 

Choose Edit | Undo to restore pBR322 then switch back to the Gal 

Cosmid window. This time, click on the XhoI site at 11,853, hold down 

the <shift> key and click on the BglII site at 16,346. 

Choose Edit | Copy to copy the fragment to the clipboard. Then switch tor 

pBR322, click on the BamHI site at 375, hold down the <shift> key 

and click on the SalI site at 651. 
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(ii) The order that you click the two sites is very important. MacVector 

always selects moving clockwise around the sequence. In this case 

we want to select the segment of the vector that we want to 

replace, so we must select BamHI first, followed by SalI. If we 

select SalI first, we would be selecting around the main core of the 

vector containing the replication origin, so the resulting construct 

would not be what we require. 

 

The display updates, inserting the XhoI to BglII fragment between the SalI 

and BamHI sites of pBR322. 

 

Note that MacVector has automatically flipped the fragment as it can only 

be inserted in one orientation. Also, no sites are regenerated at the 

BamHI/BglII or SalI/XhoI junstions. 

You can use this simple Copy-Paste approach for most of your restriction 

enzyme based clonings, safe in the knowledge that MacVector will not let 

you create invalid constructs. However, MacVector has a second set of 

functions for clone construction that are even more flexible and are 

discussed in the next section. 

 

Clone Construction Using the Cloning Clipboard 

The Cloning Clipboard is a unique MacVector window that maintains a 

history of your clone manipulations. You can view the window by 

Choose Edit | Paste. 

Choose Edit | Undo to restore pBR322 back to its original state. 
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choosing Window | Show Cloning Clipboard. This works in conjunction with 

the Digest and Ligate toolbar buttons and menu items to simplify many 

aspects of clone construction, particularly for multi-fragment clonings. 

A Simple Single Enzyme Cloning 

Lets replicate our EcoRI fragment cloning, but now using the Cloning 

Clipboard. 

 

 

The Cloning Clipboard window opens with a schematic of the digested 

fragment. Note the ends of the fragments have a label with the enzyme 

used to cut the fragment. 

 

A second fragment appears on the Cloning Clipboard. 

 

Select the two EcoRI sites in Gal Cosmid and then click on the Digest 

button on the toolbar. You can also use the Edit | Digest menu item. 

Switch to pBR322, select the EcoRI site and then click on the Digest 

button. 
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Every time you click on Digest, the resulting fragment is saved on the 

Cloning Clipboard. The fragments are remembered permanently – if you 

shut down MacVector and re-open it, you will find the same fragments 

remain on the clipboard. You can of course clear the clipboard by clicking 

on the Remove All button, or by selecting individual fragments and clicking 

on Remove. 

 

A ligation dialog sheet appears. The staggered “sticky ends” are clearly 

shown. In addition, they are outlined in blue, indicating that the ends are 

compatible. This is very similar to the ligation dialog we saw earlier with 

the copy/paste cloning, except that in this case only two ends are involved. 

 

A new fragment appears in the window, with the two molecules joined 

together. 

Click in the circle at the left hand end of the upper Gal Cosmid 

fragment. The circle highlights and “target” dots appear within the 

circles at the ends of the other fragment. Hold down the mouse button 

and drag towards the right hand end of the pBR322 fragment. Let go 

when the circle there becomes highlighted. 

Click on the Ligate button. 



 

Click Cloning Tutorial   27 January 2020 

 

Click Cloning Tutorial    15 

 

A new window appears with the selected fragment circularized. 

 

The default title is a description of the way that the molecule was 

constructed. Lets clean it up a little. 

 

Depending on the version of MacVector you are using, the center label 

may not change to reflect the new name of the sequence. If that happens; 

Either (a) click on the Circularize button or (b) click in the circle at one 

end of the new fragment and drag the line onto the other end. 

Choose File | Save and save the sequence to a suitable location (e.g. your 

desktop) under the name “Forward”. 
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You should end up with a nicely formatted construct; 

 

Flipping The Inserted Fragment 

Now let’s make a construct with the fragment inserted into pBR322 in the 

opposite orientation. 

 

 

Double-click on the label in the center of the circle. This will open up the 

Symbol Editor at the Title tab. Click on the down arrow at the right end of 

the Title edit box and select the <Sequence Name> item. 

Click in the circle at the left hand end of the upper Gal Cosmid 

fragment. Now hold down the mouse button and drag towards the LEFT 

hand end of the pBR322 fragment. Let go when the circle there becomes 

highlighted. 
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This time, the fragments get joined together in the opposite orientation. 

 

 

 

Using the Agarose Gel Simulation Interface To Determine Orientation 

In a practical experiment, you cannot directly control the orientation that 

the EcoRI fragments gets inserted into the vector, so you have to screen 

the clones to determine which have inserts in the correct orientation. The 

typical approach to do this is to cut with appropriate restriction enzymes 

and run an agarose gel and analyze the resulting pattern to identify the 

correct clones. 

MacVector has a unique Agarose Gel Simulation interface that lets you 

view photo-realistic gels so you can quickly and easily determine which 

restriction enzymes will give you a distinctive pattern so that you can 

identify clones with the insert in the preferred orientation. 

 

Repeat the circularization of the fragment and save the new circular 

molecule under the name “Reverse”. 

Choose the File | New | Agarose Gel menu item. 
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A window opens containing a graphic of a simulated agarose gel. By 

default, two marker tracks will be already visible. You can change the 

preferred marker tracks by clicking on the Prefs toolbar item. You can also 

add any other preferred markers by clicking on the Add Marker toolbar item 

and selecting a suitable marker from the popup menu. 

 

 

 

 

 

 

 

Arrange the windows so that you can see both the Untitled agarose gel 

window and the Forward sequence window (set to the Map tab) at the 

same time. Click and hold on one of the EcoRI sites in the Forward 

window, then drag the selected site onto the agarose gel window and 

release the mouse button. 
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A new track will appear on the gel, showing the predicted banding pattern 

resulting from digesting Forward with EcoRI. If you “mouse-over” the 

bands you will see that a tooltip appears with the size of the bands and the 

status bar at the bottom of the window gives more information on the 

fragment under the mouse. 

 

 

 

 

 

 

Repeat the drag and drop, but choosing first the SalI and then the SmaI 

sites in Forward. Finally click on the single HindII site, hold down the 

<shift> key, then click and hold on the single NotI site so that both 

sites highlight, then drag BOTH sites onto the agarose gel. 
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The gel updates with the predicted patterns produced by digesting Forward 

with each enzyme, or combination of enzymes. You can use the multiple-

selection trick to digest a sequence with any number of restriction 

enzymes. 

 

 

 

 

 

The gel updates to show the different digestion patterns. You can 

immediately see that the SmaI digests of the two constructs are identical, 

but the SalI and HindIII+NotI digests do give easily distinguishable 

patterns. 

Removing A Restriction Site From A Vector 

One common cloning operation that has historically been difficult to 

replicate in software is when you want to remove a restriction enzyme site 

from a vector by cleaving with an enzyme and the filling in or cutting back 

to remove the site and sometimes even creating a new RE site. This is easy 

to reproduce using the Cloning Clipboard; 

 

The Cloning Clipboard updates to show the linearized vector; 

Bring Reverse to the front and repeat the drag and drop of SalI, SmaI 

and HindIII + NotI sites. If you are careful, you can drop each site slightly 

to the right of each of the Forward digests. Alternatively, you can click 

on a track and reposition it by simply dragging it to the left or right. 

Bring the pBR322 window to the front. Click on the EcoRI site at the 12 

o’clock position and click on the Digest button 
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A new window appears containing the recircularized plasmid, but now 

missing the EcoRI site, here shown zoomed in to the residue level in the 

Map tab; 

 

Click on the Circularize button then select the two Fill radio buttons to fill 

in the two ends of the fragment. 

Click on the Ligate button. 
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Multi-Fragment Gateway Cloning 

The real power of the Cloning Clipboard becomes most apparent when you 

are trying to replicate 3-fragment cloning experiments. One common 

example of this type of approach is the MultiSite Gateway® Technology 

from Invitrogen. This uses in vitro recombination driven by a series of 

related phage att sites to quickly generate constructs made from multiple 

fragments with high efficiency. For more details, check out the 

information on the Invitrogen web site; 

http://www.invitrogen.com/site/us/en/home/Products-and-

Services/Applications/Cloning/Gateway-Cloning/MultiSite-Gateway-

Technology.html 

For this example, we will see how simple it is to generate a construct 

consisting of three separate fragments joined end to end and inserted into a 

suitable target vector. Each fragment has been inserted into an “Entry” 

vector – the constructs can all be found in the 
/Applications/MacVector/Tutorial Files/Click Cloning/ 

folder. 

vectorA.nucl – contains fragA flanked by attL4 and attR1 sites 

vectorB.nucl – contains fragB flanked by attL1 and attL2 sites 

vectorC.nucl – contains fragC flanked by attR2 and attL3 sites 

pDESTR4R3.nucl – this is a “Destination” vector with attR4 and attR3 

sites. 

The strategy here is that we will join the fragments together to form a 

construct; 

…attL4-fragA-attR1/attL1-fragB-attL2/attR2-fragC-attL3… 

and then insert that into pDESTR4R3. For the purposes of manipulation of 

the att sites in MacVector, we can treat them just like restriction enzymes 

with long asymmetrical overhangs. While the experimental in vitro 

operation is a recombination rather than a ligation, the end results will be 

identical. 

 

Choose File | Open and open each of the sequences vectorA.nucl, 

vectorB.nucl, vectorC.nucl and pDESTR4R3.nucl. 

In the Map tab of vectorA.nucl, click on the attL4 site at 629, hold 

down the <shift> key and click on the attR1 site at 5530, then click on 

the Digest toolbar button. 

Switch to vectorB.nucl, select from the attL1 site at 648 to the attL2 

site at 2063 and Digest. 

Finally, switch to vectorC.nucl and digest the fragment from the 

attR2 site at 733 to the attL3 site at 1483. 

http://www.invitrogen.com/site/us/en/home/Products-and-Services/Applications/Cloning/Gateway-Cloning/MultiSite-Gateway-Technology.html
http://www.invitrogen.com/site/us/en/home/Products-and-Services/Applications/Cloning/Gateway-Cloning/MultiSite-Gateway-Technology.html
http://www.invitrogen.com/site/us/en/home/Products-and-Services/Applications/Cloning/Gateway-Cloning/MultiSite-Gateway-Technology.html
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The Cloning Clipboard should now look like this; 

 

 

 

 

 

 

 

Click on the circle at the right end of fragA (marked as attR1), hold 

down the mouse and drag the line onto the attL1 circle at the left end of 

fragB, then release the mouse. 

In the ligation sheet that drops down, click on the Ligate button. 
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A new ligated fragment should appear on the Cloning Clipboard; 

 

Again, a new fragA+fragB+fragC fragment should appear in the Cloning 

Clipboard with an attL3 site at one end and an attL4 site at the other. 

 

Now drag the attR2 end of the fragC fragment to the attL2 end of the 

new fragA+fragB fragment and Ligate. 
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The Ligate toolbar button always tries to paste in the currently selected 

fragment on the Cloning Clipboard. Note that MacVector knows that the 

fragments needs to be flipped before it will “ligate” with the vector. 

 

 

 

Leave the new fragment selected in the Cloning Clipboard and switch to 

the pDESTR4R3.nucl window. Select the attR4 site at 40 followed by 

the attR3 site at 1726, then click on the Ligate button on the toolbar. 

Click on the Ligate button. 
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The final construct has the three fragments inserted in the correct 

orientation and exactly duplicates results of an in vitro recombination 

experiment of a mix of all four starting plasmids.  

These general approaches can be used to simulate any multi-fragment 

cloning, whether using regular restriction enzymes or Gateway att sites. 

The fragments on the Cloning Clipboard can be selected and deleted, or the 

entire clipboard cleared using the buttons at the bottom of the window. 

The fragments can also be re-ordered by dragging and dropping into a new 

location. Finally, you can Edit | Copy any selected fragment on the Cloning 

Clipboard to copy it to the regular shared system clipboard (also known as 

the “pasteboard”) if you want to paste the sequence into another 

application. 
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